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Computer Genius

Answer Key5
Class

	Data Storage and Memory

 (Page no. 7)

	

Quest  (Page no. 11)

1. 	 Digital Versatile or Video Disc (DVD)
2. 	 Pen Drive 
3. 	 Random Access Memory (RAM)
4. 	 Hard Disk

EXERCISE

A.	 1. (iii)			   2. (i)			  	 3. (ii)				   4. (i)

B.	 1. Volatile		  2. Permanent 		  3. Zettabyte 		  4. USB

C.	 1.	� A circular metallic disk covered with a magnetic coating, that is used for storing data, is called 
a Magnetic disk. 

	 2.	� Memory card is used to store data. It is very small in size usually 1–1.5 inches. These are used 
in mobile phones and digital cameras.

	 3.	� A group of 4 bits is known as a nibble (half a byte). Memory card is used for store data. Other 
units for measuring the computer’s memory are kilobyte, megabyte, gigabyte, etc. 

1.
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	 4.	 Secondary storage devices are categorised into three types: 

		  a.	� Magnetic Disk: A circular metallic disk covered with a magnetic coating, that is used for 
storing data, is called a Magnetic disk. You can record and erase data on a magnetic disk 
any number of times. 

		  b.	� Optical Disc: An optical disc is an electronic data storage medium that can be written to 
and read using a low-powered laser beam. The lifespan of an optical disc is longer than 
a magnetic disk.

		  c.	� Flash Drive: The Flash Drive is a small portable data storage device integrated with a USB 
(Universal Serial Bus) connector. 

	 5.	 a. 	 We can say that a collection of raw and unorganised facts is known as data. 

		  b. 	 When we organise the data and provide a specific context, it can be called information.

FUN ZONE

1.  MEMORY CARD	 2. HARD DISK	 3. FLASH DRIVE	 4. MAGNETIC DISK

1. 	 We can use memory card to increase our smart phone’s storage space.

2. 	 She can choose pen drive or flash drive for smooth exchange of data.

	Introduction to Excel 2016

 (Page no. 14)
Do it yourself.

Quest  (Page no. 19)
1. (c)	 2. (d)	 3. (e)	 4. (a)	 5. (b)

EXERCISE

A.	 1. 	 (iii)			  2. (iii)		  3. (i)				   4. (iv)			   5. (iv)

B.	 1. 	Name box	 2. Title		  3. Quick Access	 4. Formula		  5. Worksheet

C.	 1. 	T			   2. T			   3. F				    4. F				    5. F

D.	 1.	� The row heading is the gray coloured number (1,2,3…etc) located in front of each row in the 
worksheet.

	 2.	� Ribbon is like a strip that has various tabs such as Home, Insert, Page, Layout, Formulas and 
Data.

2.
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	 3.	� The currently selected cell that appears highlighted with the green border is an active cell.

	 4.	� While working in Excel, the following types of data can be entered:

		  a.	� Numbers: Numbers include the digits (0–9) and their various combinations. All types 
of calculations can be done on numbers. 

		  b.	� Text: Text includes the collection of letters, numbers, and special characters. No 
mathematical calculation can be performed on text. 

	 5.	� To enter data, follow the given steps: 

		  Step 1: Click on the cell where you want to enter the data and start typing. 

		  Step 2: To move down one cell, press the Enter key. 

	 	 Repeat Steps 1 and 2 until you finish entering all your data.

	 6.	� Contiguous Cell Range is a collection of cells that are adjacent to or next to one another. A 
colon (:) is used for specifying this cell range, for example, A1:A6. Non-contiguous Cell Range 
is a collection of cells that are not adjacent to one another. A comma (,) is used for specifying 
this cell range, for example, A1, B2, C3.

	 7.	 To create a new workbook in Excel 2019, follow the given steps:

		  Step 1 Click on File tab. 

		  Step 2 Click on the New option.

		  Step 3 Click on Blank workbook.

		  A new workbook will be created.

FUN ZONE

A.	 1. D3			   2. D5		  3. E4			  4. C4		  5. B4			  6. G4

B.	 1   Click on the File tab.

	 3   Click on Browse option.

	 2   Click on Save or Save As option.

	 5   Type a name for your file in the File name box.

	 6   Click on the Save button.

	 4   Select the location where you want to save your workbook.

1. 	 To save a workbook, follow the given steps: 

	 Step 1: Click on the File tab.

	 Step 2: Click on Save or Save As option. 
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	 Step 3: Click on Browse option. 

	 Step 4: Select the location where you want to save your workbook.

	 Step 5: Type a name for your file in the File name box. 

	 Step 6: Click on the Save button. 

2. 	 To fill the time-table, follow the given steps: 

 	  Step 1 Click on the cell where you want to enter the data and start typing. 

 	  Step 2 To move down one cell, press the Enter key. 

 	  Repeat Steps 1 and 2 until you finish entering all your data.

	More on PowerPoint 2016

  (Page no. 26)

1.  F				    2. T				    3. �T				    4. F

Quest  (Page no. 31)

1.  Align Left		  2. Align Right			   3. Center			   4. Justify

Quest  (Page no. 39)

1.  Pictures		  2. Online Pictures 		  3. Shapes			  4. SmartArt 

EXERCISE

A.	 1. 	 (ii)			   2. (iii)			   3. (iii)			   4. (iii)

B.	 1. 	slide		  2. Design			  3. Format			  4. Justify

C.	 1. 	 (d)			   2. (c)				   3. (b)			   4. (a)

D.	 1.	� The Slide Show tab will let you set up how your show will progress.

	 2.	 The four types of alignment are Align Left, Align Right, Center and Justify. 

	 3.	 To insert Online pictures in the document, follow the given steps:

		  Step 1 Click on the Insert tab.

		  Step 2 Click on the Online Pictures option.

		  Step 3 Type a word in Bing Image Search box.

		  Step 4 Select the picture, you want to insert.

		  Step 5 Click on the Insert button.

3.
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	 4.	 To insert shapes on the slide, follow the given steps:

		  Step 1 Click on Insert tab.

		  Step 2 Click on Shapes command in the Illustration group.

		  Step 3 Choose a desired shape from the drop down menu.

		  The selected shape will be inserted on the slide.

FUN ZONE

1. SLIDE	 2. PRESENTATION 	 3. BACKGROUND		  4. PLACEHOLDER 	
5. SMARTART

1. �	� Rohit can add pictures by using Picture command and Online Pictures command from Insert tab. 
He can also use placeholder to insert pictures.

2. 	 She can add themes from the Design tab to make slides look more colourful and attractive.

Periodic Assessment 1
(Based on chapters 1 to 3)

A.	 1. Read Only Memory (ROM) 		  2. Hard Disk 		  3. Random Access Memory (RAM) 	

	 4. Blu-Ray Disc					     5. Pen Drive		  6. Memory Card

B.	 1. Themes  		  2. Justify		  3. Pictures		  4. WordArt 

	 5. Placeholder
C.	

Name box 

Quick Access Toolbar Title Bar 

Ribbon

Formula bar 

Worksheet 
Tabs Status bar 
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	Internet and E-mail

 (Page no. 44)

1. Search information 	 	 2. Take a bath	

3. Find a recipe 		  	 4. Send an email	

5. Download an image 	 	 6. Pack your bag	

7. Do shopping		  	 8. Online communication	

Quest  (Page no. 48)

1. 	 Advanced Research Projects Agency 

2. 	 Advanced Research Projects Agency Network

3. 	 Transmission Control Protocol

4. 	 Internet Protocol

5. 	 World Wide Web

6.	 Hypertext Transfer Protocol

7. 	 National Center for Supercomputing Applications

8. 	 Uniform Resource Locator

EXERCISE

A.	 1. (i)		  2. (i)		 3. (iii)	 4.(iii)		 5.(ii)		 6.(ii)

B.	 1. Bcc		  2. To		 3. Cc 	 4. Attachment 		 5. Sent

C.	 1. F		  2. T		  3. F		  4. F		  5. F

D. 	�1.	� A Web server is an Internet host computer that often stores thousands of individual Web 
pages. 

	 2.	� Emoticons are used to represent the facial expressions. They help in telling your mood to 
others as well as save typing time. 

	 3.	� Yes, we can send a video file as attachment in an e-mail through ‘attach files’ option. 

	 4.	� The New Message window has many fields: 

	 	 •	� To: In this field, type your friend’s e-mail address. You can enter more than one address 
by pressing ‘,’ after each e-mail address. 

	 	 •	� Cc: Cc stands for carbon copy. It is marked to the e-mail address who is to be informed 
that an e-mail has been sent to the person marked in To field. 

 

4.
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	 5.	� Logging In or login is the process of accessing your e-mail account by providing the user 
name and password. 

	 6.	�� URL stands for Uniform Resource Locator. It helps us navigate the Web. We can specify a URL 
in several ways, but two methods are commonly used:

		  a. 	 Using Address Bar: 

			   Step 1 Type the URL in the browser’s Address bar. 

			   Step 2 Press the Enter key from the keyboard. 

		  b. 	 Using Hyperlink: 

			�   A hyperlink is simply a part of the Web page that is linked to a URL. A hyperlink can appear 
as text, an image, or a navigational tool such as a button or an arrow. You can click a 
hyperlink and jump from your present location to the URL specified by the hyperlink. 

FUN ZONE

1.  Cc			   2. To 		  3. Subject			  4. Bcc

1.	 By clicking on the Attach files button in the New Message window.

2. 	 Sushant should write Ajay’s e-mail in ‘To’ and others’ e-mail addresses in ‘Bcc’.

	Data Processing

  (Page no. 61)
Do it yourself.

Quest   (Page no. 63)

1. No Parking 		 2. Veg and Non-Veg 	 3. Wheelchair		  4. Zebra Crossing 	

5. No U-Turn 		  6. Hospital

Quest   (Page no. 64)
4%#32

EXERCISE

A.	 1. (ii)		  2. (iii)	 3. (iv)

B.	 1. T		  2. F 		  3. F

C.	 1.	� Data refers to the raw input. When this data is processed, the outcome received is known as 
information. 

5.
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	 2.	 We can represent information in the following ways:  

		  a.  �	in the form of tables, for example, class timetable. 

		  b.  	in the form of pictures, drawing and so on. 

		  c.  	 in the form of maps. 

		  d. � 	in the form of pictograms, for example, road signs. 	

FUN ZONE

A.	 (i) 	

B.	 (iii)

1. He can sort his things.

2. By using Coded data.

	Creating Shapes in Scratch

  (Page no. 67)

1. Hat block 		  2. Stack block 		 3. Reporter block 	 4. Boolean block 	 5. C-block

Quest  (Page no. 71)

1.	 Heptagon 		 2. Triangle 		  3. Pentagon 		  4. Nonagon		  5. Hexagon  

6.	 Octagon

EXERCISE

A.	 1. (ii)			   2. (ii)			  3. (i)

B.	 1. Polygon		 2. 360		  3. Go		  4. Hexagon 

C.	 1. F			   2. F			   3. T			   4. T

D.	 1.	� The Pen blocks draw a trail as the Sprite moves on the stage.

	 2.	 One of the thumb rule to draw polygons in Scratch is:

	 	 •	 �You must know the number of sides in the shape. This is the value to be given in repeat 
block. For example, you give repeat 3 to draw a triangle and 4 to draw a square.

	 3.	� To add Pen block, follow the given steps: 

		  Step 1: 	Click on the Add Extension button at the bottom left corner of the Code tab. 

6.
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		  Step 2: �Click on Pen option. The Pen blocks are added to the Code table and 4 to draw a 
square.

FUN ZONE

1. �Sides : 0, Degree : 360			  2. Sides : 3, Degree : 120

3. Sides : 4, Degree : 90			   4. Sides : 4, Degree : 90

5. Sides : 5, Degree : 72			   6. Sides : 6, Degree : 60

1. 	 Pen blocks

2. 	 Repeat 3, Move 100 Steps, Turn 120 degrees

Periodic Assessment 2
(Based on chapters 4 to 6)

A.	 1. 	 It is the folder where all e-mails that you have received from others are stored. 

	 2. 	 It is the folder where all e-mails that you send to others are stored. 

	 3. 	 It is the folder where all outgoing e-mails are temporarily stored. 

	 4. 	� It is the folder where all unwanted incoming e-mails are stored so that they stays out of the 
inbox folder. 

	 5. 	 It is the folder where all deleted e-mails are usually stored for a defined time period.

B.	 1. 	Sorting		  2. Information		 3. Website		  4. Coded data		 5. Decoding

C.	

(Based on chapters 1 to 6)
Test Sheet 1

A.	 1. 	 (i)			   2. (iv)		  3. (iii)		  4. (ii)			  5. (ii)			  6. (iii)		  7. (i)

B.	 1. 	Volatile 	 2. Zettabyte 	 3. Title 		  4. Placeholder 		 5. Cc 

C.	 1. 	T			   2. T			   3. F			   4. F			   5. F			   6. T

D.	 1. 	 (d)			   2. (c)			  3. (b)		  4. (a)

E.	 1. 	a.	 Data refers to the raw input. 

		  b. 	 When this data is processed, the outcome received is known as information. 
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	 2. 	While working in Excel, the following types of data can be entered:

		  a. 	� Numbers: Numbers include the digits (0–9) and their various combinations. All types of 
calculations can be done on numbers. 

		  b. 	� Text: Text includes the collection of letters, numbers, and special characters. No 
mathematical calculation can be performed on text.

	 3.	 To insert Online pictures in the document, follow these steps: 

		  Step 1: Click on the Insert tab. 

		  Step 2: Click on the Online Pictures option. 

		  Step 3: Type a word in Bing Image Search box. 

		  Step 4: Select the picture, you want to insert. 

		  Step 5: Click on the Insert button.

	 4. 	E-mail has various advantages, some of them are: 

	 	 •	 An e-mail can be sent anytime and from anywhere in the world. 

	 	 •	 An e-mail can be sent to many people at a time. 

	 	 •	 An e-mail can be easily forwarded to anyone without typing it again. 

	 	 •	 Sending an e-mail is fast in comparison to traditional mails.

	 5. 	We can represent information in the following ways: 

		  a. 	 In the form of tables, for example, class timetable. 

		  b. 	 In the form of pictures, drawing and so on. 

		  c. 	 In the form of maps. 

		  d.	 In the form of pictograms, for example, road signs. 

	 6. 	To add Pen block, follow the given steps: 

		  Step 1: Click on the Add Extension button at the bottom left corner of the Code tab. 

		  Step 2: Click on Pen option. The Pen blocks are added to the Code tab.

	Advanced Blocks & Game Creation

 (Page no. 80)

7.
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Quest  (Page no. 83)

1. 	 ask and wait block

2. 	 key pressed?

3. 	 The blocks that end scripts are known as CAP blocks. 

4.	 C blocks are loop blocks to check if a condition is true in the blocks within the loop. 

Quest  (Page no. 88)

1. �	� If a variable is created, to be used and modified by all the sprites, then it is known as a global 
variable.

2.	� If a variable is created to be used and modified by a single sprite only, then it is known as a local 
variable.

EXERCISE

A.	 1. 	 (iii)			  2. (i)				   3. (i)			  4. (ii)	

B.	 1. 	script 		  2. touching color 	 3. local 		  4. ask and wait

C.	 1. 	T			   2. T				    3. F			   4. F

D.	 1.	� Scratch blocks can be divided into six types of shapes. They are: Hat, Stack, Boolean, Reporter, 
C and Cap. 

	 2.	� The sensing blocks in Scratch sense the input from the keyboard or the mouse at the time of 
execution of a script. 

	 3.	 There are two types of variables. They are: Global Variables and Local Variables.

	 4.	� Scratch has two conditional blocks. They are: 

	 	 • �	 �If,then block: In this block if the condition is true, the blocks inside conditional block will 
run. If the condition is false, the blocks inside conditional block will not run. Only the blocks 
outside the conditional block will run. 

	 	 • �	 �If,then,..else block: In this block if the condition is true, the blocks inside then condition 
will run. If the condition is false, the blocks inside else condition will run.

FUN ZONE

A. 	1. The sprite will rotate 360 times. Each time it will turn at 30 degree and move 10 steps.

	 2. The sprite will turn 15 degrees. It will keep on moving till user stops the program.

B.	 Do it yourself.

1.	 ask and wait block

2. 	 touching mouse-pointer ? block
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	AI in Popular Apps

 (Page no. 92)
1. 	 Grammarly		 2. Duolingo

Quest  (Page no. 96)
1.	 ChatGPT		  2. Google Maps		  3. Swiggy			  4. Netflix

EXERCISE

A.	 1. (iii)		  2. (ii)			  3. (ii)			  4. (i)

B.	 1. F		  2. T			   3. T			   4. T

C.	 1.	 Swiggy, Ola

	 2. �	� Netflix uses AI to understand the user’s preferences and suggests content according to the 
users’ liking.

FUN ZONE

A.	 1. YouTube		 2. Netflix		  3. ChatGPT

1.  Swiggy			  2.  Google Maps

	Trending Robots

  (Page no. 100)

1.	 Driverless Car		  2.  Smartphone		  3.  Smartwatch

Quest  (Page no. 104)

Do it yourself.

EXERCISE

A.	 1. (i)			   2. (iii)			   3. (iii)		  4. (i)				   5. (ii)

B.	 1. Robotics		 2. RoboThespian	 3. T-HR3 		 4. Dash & Dot 	 5. Paro

C.	 1. F			   2. T				    3. T			   4. F

8.

9.
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D.	 1. �Robots are automatically operated machines that work in place of humans. It is not necessary 
that they look like humans by appearance or perform exactly like humans. 

	 2. �Robotics is a branch of engineering and science that deals with the design, construction and 
functioning of robots. 

	 3. a. Z-Machines	 b. Nao		  c. Leka		  d. RoboThespian		  e. Robear

FUN ZONE

1. Sophia 		 2.  Leka 		  3. Digit 		  4. RoboThespian 		  5. Paro		  6. Root

1. 	 Robear			 

2. 	 (This question was printed incorrectly in the book. Please correct it in your textbook.)

	 Question: �Suppose, you wants to learn coding using a robot. Which robot would you use to 
do so?

	 Ans. Root

Periodic Assessment 3
(Based on chapters 7 & 9)

A.	 1.  C-Blocks	 2. Hat Blocks		  4. �Reporter Blocks

B.	 1.	 Hat blocks always come at the top of a script.

	 2.	 A Script is made up of number of blocks.

	 3.	 In scratch, a program is called a Script. 

C.	 1. 	Swiggy		  2. Uber	 		  3. YouTube

D. 	1. 	Robear	 	 2. Dash & Dot		 3. Z-Machines

	   Angles and Value Conversion

  (Page no. 111)

1. 	 It is a category of colour-coded blocks that we can drag to the Script area.

2. 	 It is used to reset the scripts on clicking.

3. 	 It is used to start the code or test it on clicking.

4. 	 It is used to delete blocks from the Script area.

5. 	 Blocks are dragged here from the block palette to make code.

10.
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Quest  (Page no. 119)

1. 	 Draw category		  2. Conversion category		  3. Output category

4. 	 Input category		  5. Variable category		  6. Draw category

EXERCISE

A.	 1. 	 (ii)			   2. (i)			  3. (ii)			  4. (i)			  5. (iv) 		  6. (iv)

B.	 1. 	degree		  2. right		  3. circle		  4. Int		  5. Input block	 6. Boolean

C.	 1. 	T			   2. F			   3. T			   4. T			   5. F			   6. F

D.	 1. 	 (b)			   2. (c)			  3. (e)		  4. (a)			  5. (d)	

E.	 1. �	Functions block is used to avoid rewriting same logic/code again and again in a program.

	 2.	 Int, Float, String

	 3.	� When two lines going in different directions cut each 
other at a point, they form an ‘Angle’. Angles are 
measured in ‘Degrees’ (°).

		

	 4.	 The easiest way is to use a single motion block, such as make turtle...a dot of radius block.

	 5.	 To turn a turtle in AI Connect, follow the given steps:

		�  Step 1: 	�Create a new variable ‘T’ from the Variables category. Add set T to block in the script 
area.

		�  Step 2: 	�Add create new turtle block, from the Turtles blocks under Draw category, inside the 
set T to block.

		�  Step 3: 	�Attach make turtle turn right by block from the Motion block under the Draw category 
and enter input angle 90.

		  Step 4: 	Click on the Run button.

	 6.	 (This question was printed incorrectly in the book. Please correct it in your textbook.) 
		  Question: Briefly explain about the types of values. 

		  Ans. The following are the types of values that we can enter in coding:
	 	 	 	 • �	 �Integers (Int): Integers are whole numbers that can be positive, negative or 0, for 

example: 1, 2, 4, 0, 67, 45, -89, -132 etc. 
	 	 	 	 • �	 �Float (float): Floats are numbers that are written with a decimal point in them. For 

example: 3.4, -432.6, 3.14, 0.5, 4.0, etc. 
	 	 	 	 • �	 �Boolean (bool): Boolean kind of variables have only two values: True or False. We can 

verify any kind of statement or condition in a code using a Boolean command. 
	 	 	 	 • �	 �String (str): Strings are a sequence of one or multiple characters like alphabets, numbers 

or symbols.	
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FUN ZONE

A.	 1.	 		  2.  

B.	 Do it yourself.

1. 	 make turtle...a dot of radius block

2.	 input with prompt block

	   Math Operators and Loops

  (Page no. 123)

(This question was printed incorrectly in the book. Please correct it in your textbook.) 

Question: 

1.
a. This input block adds Boolean value 

to a code. It can declare a variable or 
statement either  true or false.

2.
b. It converts all the letters in a variable to 

lower case. 

3.
c. This block also inputs string values in 

the code. Just enter any statement in the 
space given in the block.

4.
d. It converts the input into string datatype. 

Ans. 1. (c) 	 2. (a) 	 3. (d) 	 4. (b)

Quest  (Page no. 127)

1. (d) 		  2. (a)		  3. (b)		  4. (c)

EXERCISE

A.	 1. (iv)			   2. (i)			  3. (iv)		  4. (ii)			  5. (iii)

B.	 1. Variables	 2. Operators	 3. Loops		  4. multiplication table

C.	 1. (d)			   2. (a)			  3. (c)			  4. (b)

11.



Computer Genius-V (Answer Key)16

IMPRINT 1

D.	 1. �	� Repeat command block simply repeats the blocks attached to it for a certain number of times. 
Repeat while block also repeats a set of commands in a code but only till a specified condition 
is met. 

	 2. �	Round-up is a math feature majorly used in shopping bills to find the nearest upper value. 
	     	Round-down is a math feature mainly used in shopping bills to find the nearest lower value.

	 3. 	Math blocks are used to: 

	 	 • 	 Calculating total sum 

	 	 • 	 Solving math problems

	 4.	 Code to add two numbers, 14 and 21:

		�  Step 1: 	�Add print block, inside it at add Addition block.

		�  Step 2: 	�Write 14 on the one side in the Addition block and 21 on the other side. 

FUN ZONE

1. 	 It will print the one less number that the user entered 50 times.

2.	 It will print 1 to 10 counting.

1. 	 5832		  2. For loop		  3. Repeat block

	  AI in Real World

  (Page no. 131)

Female, Male

Quest  (Page no. 104)

1. 	 F 			   2. F 			   3. T 			  4. T

EXERCISE
A.	 1. 	 (iii)			  2. (ii)			  3. (ii)	

B.	 1.	 Some of the features of robots are as follows: 
	 	 • 	 Robots make complex task easy.
	 	 • 	 They never get tired for doing repetitive tasks.
	 	 • 	 They can work anywhere.

	 2.	� Click on image icon of Load Image block. Click on Browse button to load image from computer 
or click on Capture to capture image using webcam. Click on Submit button after loading an 
image.

12.
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FUN ZONE

In the given code Load Image block is not present.

To correct the code add Load Image block at the top of the code.

To add Load Image block, extend the AI Learning category from the block-palette and select the 
Facial Feature sub-category. Then add Load Image block at the top of the code.

1. 	 Setting button of if-do block

2.	 From AI Learning category

Periodic Assessment 4
(Based on chapters 10 to 12)

A.	

B.	 1. 13		  2. 37 

C.	 1. AI Learning category		  2. Input category		  3. Logic category

(Based on chapters 7 to 12)
Test Sheet 1

A.	 1. 	 (iii)			  2. (ii)			  3. (i)			  4. (i)			  5. (i)			  6. (i)			  7. (ii)

B.	 1. 	 touching color	 2. RoboThespian		  3. T-HR3		  4. degree		 5. Operators

	 6. 	Loops 

C.	 1. 	F			   2. T			   3. T			   4. F			   5. T

D.	 1. 	 (d)			   2. (a)			  3. (c)			  4. (b)

E.	 1. 	There are two types of variables. They are: Global Variables and Local Variables.
	 2. �	� Netflix uses AI to understand the user’s preferences and suggests content according to the 

users’ liking.
	 3. �	� Robotics is a branch of engineering and science that deals with the design, construction and 

functioning of robots. 
	 4. 	The easiest way is to use a single motion block, such as make turtle...a dot of radius block.
	 5. �	� Click on image icon of Load Image block. Click on Browse button to load image from computer 

or click on Capture to capture image using webcam. Click on Submit button after loading an 
image.


